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如何設定可保存變數與資料儲存? 
 

 1.1. 可保存變數 (Retain Variable) 

此文件將介紹如何使用 "RETAIN_VAR"、"RETAIN_ARY"、"RETAIN_FLAG_GET"、"RETAIN_FLAG_SET" 

與 "RETAIN_FLAG_CLR" 函式 (Function)，Win-GRAF 系列 PAC 內建有一個資料保存記憶區，可供

使用者保存變數資料，此資料不會因關機而消失，下次開機時仍為上一次的值。 

 

註: "Retain_Var()"  或 Retain_Ary() 函式，只能在第一個 PAC Cycle 或 執行線上更新 (On-line 

Change) 的那個 Cycle 內使用，於其它 Cycle 內呼叫此函式，將會回傳 "FALSE"。當保存變數

尚未指定過任何初值時，PAC 程式執行此函式所讀到的值並無意義，使用者至少需為所有的

保存變數指定適合的初值一次。 

 

此文件提供了 2 個範例程式 (demo_retain.zip 與 demo_wp5_retain.zip)，請開啟 Win-GRAF 並 

點選功能表 File > Add Existing Project > From Zip 來回存 "demo_retain" 專案 (或參考 FAQ-003)。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

您可點選 "Variables“ 開啟變數視窗，來查詢/設定此程式所使用的變數 (如下圖)，若您想了解 

變數的宣告方式，可參考 Win-GRAF 快速上手手冊 (2.2.2 節 與 2.3.1 節)。  

 
 
 
 
 
 

http://ftp.icpdas.com/pub/cd/win-graf-pac-cd/napdos/win-graf/manual/chinese/
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注意:  ICP DAS Win-GRAF PAC 並不支援 "Variable" 視窗中的 "Retain Variable“ 功能，因此 

請使用 "RETAIN_VAR"、"RETAIN_ARY"、"RETAIN_FLAG_GET"、"RETAIN_FLAG_SET" 與 

"RETAIN_FLAG_CLR” 函式 (Function) 來實現可保存變數功能。 
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 1.2. 範例程式介紹 ("demo_retain") 

 

ST 語法: 此範例說明 Retain_Var() 與 Retain_Ary() 函式。 

   
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(* 宣告 "on_line_change_cycle" 為 "DINT" 變數， 

非 “0”  表示正在執行線上更新 (On-line Change) 的那個 Cycle 內。 

宣告 "retain_done" 為 "BOOL" 變數且設定初始值為 “FALSE” 一次。 

宣告 "tmp_bool" 為 "BOOL" 變數。  

 *) 
 

on_line_change_cycle  :=  GetSysInfo (_SYSINFO_CHANGE_CYCLE) ; 

  if (retain_done = FALSE) or (on_line_change_cycle <> 0) then 

     retain_done := TRUE ;  (* 只執行一次即可 *) 

     tmp_bool := Retain_Var ( DINT_1 , 1) ; (* 設定保存一個 “DINT” 變數 *) 

     tmp_bool := Retain_Var ( DINT_2 , 2) ;  

     tmp_bool := Retain_Var ( REAL_1 , 3) ; (* 設定保存一個 “REAL” 變數 *) 

     tmp_bool := Retain_Var ( BOOL_1 , 4) ; (* 設定保存一個 “BOOL” 變數 *) 

     tmp_bool := Retain_Var ( BOOL_2 , 5) ;      
  

(* 設定保存 “INT” 陣列變數內的 10 個元素 *) 

     tmp_bool := Retain_Ary ( INT_ARY ,  6 ,  10) ;  

     (* 設定保存 “REAL” 陣列變數內的 20 個元素 *) 

     tmp_bool := Retain_Ary ( REAL_ARY , 16 , 20) ;  

     tmp_bool := Retain_Var ( DINT_3 , 36) ;  

 

     (* 64-bit 變數只能使用位址編號 10001 ~ 12000 *) 

     tmp_bool := Retain_Var ( LINT_1  , 10001) ;  (* 設定保存一個 “LINT” 變數 (64-bit) *) 

     tmp_bool := Retain_Var ( LREAL_1 , 10002) ; (* 設定保存一個 “LREAL” 變數 (64-bit) *) 

  end_if ; 
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 1.3. Retain_xxx 函式介紹 

 

 1.3.1. RETAIN_VAR (設定保存一個變數) 

 
 
 
 

 
 
 
 

Name:   

想要保存資料的變數名稱 (勿使用陣列變數 或 字串)，資料型態可為 BOOL, SINT, USINT, BYTE, 

INT, UINT, WORD, DINT, UDINT, DWORD, REAL, TIME, LINT, LREAL。 

 

Addr: (資料型態: “DINT”) 

用來保存變數的位址編號，可設定為  1 ~ 12000。 

 

Q: (資料型態為 “BOOL”) 

“TRUE”: 表示 OK  ; 

“FALSE”: 表示錯誤。 

 

註:  

1. 一個位址只能儲存一個變數，請勿將相同的位址指定給兩個變數 (或多個)，否則保存值將會 

出現錯誤。 

2. 64-bit 的資料型態 (例如: LINT, LREAL) 只能使用位址編號 10001 ~ 12000。 

3. 其它資料型態 (例如: BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL, 

TIME) 可使用位址編號 1 ~ 12000。 

 
 
 
 
 
 
 
 
 
 

使用小技巧:   

按 “F1” 鍵，可查看詳細的設定說明。 
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 1.3.2. RETAIN_ARY (設定保存一個陣列變數) 

 
 
 
 
 
 
 
 
 

Name[]:   

想要保存資料的陣列變數名稱 (勿使用字串 或 非陣列變數)，資料型態可為 BOOL, SINT, USINT, 

BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL, TIME, LINT, LREAL。 
 

Addr: (資料型態: “DINT”) 

用來保存陣列變數的起始位址編號，可設定為  1 ~ 12000。 
 

Num: (資料型態: “DINT”) 

陣列變數內想要保存的資料數量。 

例如，若陣列變數有 100 個元素，設定 "Num" 為 "1 ~ 100" 是正確的，但若設為大於 100  

就不對。若陣列變數有 5 個元素，則設定 "Num" 為 "1 ~ 5" 是正確的，但若設為大於 5  

就不對。 
 

Q:  資料型態為 “BOOL”，“TRUE”: 表示 OK   ;   “FALSE”: 表示錯誤。 

 

註:  

1. 一個位址只能儲存一個變數 (或陣列中的一個元素)，請勿將相同的位址指定給兩個變數 (或

多個)，否則保存值將會出現錯誤。 

2. 64-bit 的資料型態 (例如: LINT, LREAL) 只能使用位址編號 10001 ~ 12000。 

3. 其它資料型態 (例如: BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL, 

TIME) 可使用位址編號 1 ~ 12000。 

 
 
 
 
 
 
 
 

使用小技巧:   

按 “F1” 鍵，可查看詳細的設定說明。 
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 1.3.3. RETAIN_FLAG_SET/GET/CLR (設定/取得/刪除 Flag 的狀態) 

如何使用: 

“RETAIN_FLAG” 是一個儲存在保存記憶體中的旗標 (TRUE / FALSE)，可讓使用者判斷保存資料是否

為有效值。若先前保存變數未設置過任何初值，則 PAC 一開機從保存記憶體所讀到的值並不是正

確的 (一般會是個亂數值)，因此為了讓程式可正常運作，使用者至少需為所有的保存變數設定過

一次適當的值，然後可呼叫 "Retain_Flag_Set()" 將保存旗標設定為 "TRUE“，表示 "所有的保存變

數已設置了適當的值"; 呼叫 "Retain_Flag_Get()" 可取得保存旗標的狀態; 呼叫 "Retain_Flag_Clr()" 

則可刪除保存旗標的狀態。 
 

ST 語法:     

 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   (*  宣告 "on_line_change_cycle" 為 "DINT" 變數，非 “0”  表示正在執行線上更新  

(On-line Change) 的那個 Cycle 內。 

宣告 "retain_done" 為 "BOOL" 變數且初始值為 “FALSE”。 

宣告 "tmp_bool"、"retain_flag" 與 "to_set_flag" 為 "BOOL" 變數。 

  *)  
  on_line_change_cycle  :=  GetSysInfo (_SYSINFO_CHANGE_CYCLE) ; 

  if (retain_done = FALSE) or (on_line_change_cycle <> 0) then 

     retain_done := TRUE ;  (* 只執行一次即可 *) 

     tmp_bool := Retain_Var( DINT_1 , 1) ;  (* 設定保存一個 “DINT” 變數 *) 

     tmp_bool := Retain_Var( DINT_2 , 2) ;  

     tmp_bool := Retain_Var( REAL_1 , 3) ; (* 設定保存一個 “REAL” 變數 *) 

     tmp_bool := Retain_Var( BOOL_1 , 4) ; (* 設定保存一個 “BOOL” 變數 *)  

     (* ... 在執行所有的 Retain 函式後 ... *) 

     retain_flag := Retain_Flag_Get(); 
     if  (retain_flag = FALSE)  then   

        (* 若先前保存變數並未設定過適當的值，您可在此執行一些適當的操作。*) 

        (* ... *)        
     end_if ; 

  end_if ; 

  (* 當您為所有的保存變數都指定了適當的值後，請記得將以下的 "to_set_flag" 設定為 

“TRUE”，以便調用 "Retain_Flag_Set() 一次，如此，下次使用到 "Retain_Flag_Get()  時 

就會回傳 “TRUE”。 *) 

   if  (to_set_flag = TRUE)  then 
      to_set_flag := FALSE ; 
      tmp_bool := Retain_Flag_Set() ; 
   end_if ;   
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LD 語法:  (按 “F1” 鍵，可查看詳細的設定說明。) 

 

RETAIN_FLAG_SET : 設定保存旗標。 

 
 
 
 
 
 
 
 
 

Q:  資料型態為 “BOOL”，只回傳 “TRUE”。 

 
 
 

RETAIN_FLAG_GET : 取得保存旗標的狀態。 

 
 
 
 
 
 
 

Q:  資料型態為 “BOOL”， 

“TRUE”: 表示已設立旗標 (Flag) ;   

“FALSE”: 表示未設立旗標 (Flag)。 

 

RETAIN_FLAG_CLR : 刪除保存旗標的狀態。 

 
 
 
 
 
 
 
 
 

Q:  資料型態為 “BOOL”，只回傳 “TRUE”。 

 

ST 語法:   

if   to_set_flag   then 
     to_set_flag  :=  FALSE  ; 
     TMP_BOOL  :=  

Retain_Flag_Set() ; 

end_if ; 

ST 語法:   

retain_flag  :=  Retain_Flag_Get() ; 

ST 語法:   

if   to_clr_flag   then 
     to_clr_flag  :=  FALSE  ; 
     TMP_BOOL  :=  

Retain_Flag_Clr() ; 

end_if ; 
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 1.4. 可保存變數 (使用檔案方式) 

若您想使用 File 來保存變數，您可使用此章節所提供的範例程式 (demo_wp5_retain.zip) 將需 

保存的變數資料儲存在 PAC 內 \System_disk\Win-GRAF\ 目錄下的檔案中。 

 

請開啟 Win-GRAF 並點選功能表 File > Add Existing Project > From Zip 來回存 "demo_wp5_retain" 

專案 (或參考 FAQ-003)。此專案包含了 1 個 ST 主程式 (Main) 與 3 個 ST 副程式 (load_retain, 

save_retain 與 Go_retain)。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

使用限制: 

此專案並不適合處理數值會頻繁變動的保存變數 (例如: 每秒或每分鐘需變更數值)。這是因為 

變數資料是儲存在 \System_disk\ 目錄下，若保存數值常常變動，則檔案更新會消耗很多 CPU 

時間進而造成 PAC 效能低弱。  

 

以下為 "demo_wp5_retain" 專案中設定的初值，請依實際需求設定適當的值。        

MAX_VAR_REAL:  100  (最多可使用 REAL 保留變數的數量) 

MAX_VAR_OTHER: 100  (最多可使用 Integer, BOOL, TIMER 保留變數的全部數量) 

 

變數 "REAL_VAR_now" 與 "REAL_VAR_old" 的 Dim. 值 (0 ~ 99)，需和 "MAX_VAR_REAL" (100) 

的值相同。 

變數 "OTHER_VAR_now" 與 "OTHER_VAR_old" 的 Dim. 值，需和 "MAX_VAR_OTHER" 值相同。  
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註: "MAX_VAR_REAL" 與 "MAX_VAR_OTHER" 的設定值越大，表示 PAC 的 Cycle Time 也越大。

因此，請將此兩個數值設定為接近實際的使用數量即可。 

 

以下為此專案中宣告的變數，請依實際需求來宣告變數。 

    My_REAL_00    ~   My_REAL_07  (資料型態: REAL) 

    My_DINT_00    ~   My_DINT_05  (資料型態: DINT) 

    My_BOOL_00  ~   My_BOOL_02  (資料型態: BOOL) 

    My_Timer_00  ~   My_Timer_05 (資料型態: TIME)   

 

您可在 "Variables" 視窗查看更多的變數。 

 
 
 
 
 
 
 
 
 
 
 
 
 

"Go_retain" 副程式是用來執行檔案中的保存動作，請記得修改以下的 4 個區塊 (程式中註解為 

"Add your REAL variables for retain here" 與 "Add your integer, BOOL, Timer variables for retain here" 

兩個部分)，請依實際宣告的變數來修改:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Dim. 值需一致 

保存資料的儲存路徑 

     (* Add your REAL variables for retain here *) 
     (* ------------------------------------------------- *) 
     My_REAL_00 := REAL_VAR_now[0] ; 
     My_REAL_01 := REAL_VAR_now[1] ; 
     My_REAL_02 := REAL_VAR_now[2] ; 
     My_REAL_03 := REAL_VAR_now[3] ; 
     My_REAL_04 := REAL_VAR_now[4] ; 
     My_REAL_05 := REAL_VAR_now[5] ; 
     My_REAL_06 := REAL_VAR_now[6] ; 
     My_REAL_07 := REAL_VAR_now[7] ; 
     (* ------------------------------------------------- *) 
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 (* Add your integer, BOOL, Timer variables for retain here *) 
 (* ................................................. *) 
 My_DINT_00 := OTHER_VAR_now[0] ; 
 My_DINT_01 := OTHER_VAR_now[1] ; 
 My_DINT_02 := OTHER_VAR_now[2] ; 
 My_DINT_03 := OTHER_VAR_now[3] ; 
 My_DINT_04 := OTHER_VAR_now[4] ; 
 My_DINT_05 := OTHER_VAR_now[5] ;      
 
 My_BOOL_00 := Any_to_BOOL( OTHER_VAR_now[6] ) ; 
 My_BOOL_01 := Any_to_BOOL( OTHER_VAR_now[7] ) ; 
 My_BOOL_02 := Any_to_BOOL( OTHER_VAR_now[8] ) ; 
    
 My_Timer_00 := Any_to_TIME( OTHER_VAR_now[9] ) ; 
 My_Timer_01 := Any_to_TIME( OTHER_VAR_now[10] ) ; 
 My_Timer_02 := Any_to_TIME( OTHER_VAR_now[11] ) ; 
 My_Timer_03 := Any_to_TIME( OTHER_VAR_now[12] ) ; 
 My_Timer_04 := Any_to_TIME( OTHER_VAR_now[13] ) ; 
 My_Timer_05 := Any_to_TIME( OTHER_VAR_now[14] ) ; 
 (* ................................................. *) 
 
(* Add your REAL variables for retain here *) 
 (* ------------------------------------------------- *) 
 REAL_VAR_now[0]  := My_REAL_00 ; 
 REAL_VAR_now[1]  := My_REAL_01 ; 
 REAL_VAR_now[2]  := My_REAL_02 ; 
 REAL_VAR_now[3]  := My_REAL_03 ; 
 REAL_VAR_now[4]  := My_REAL_04 ; 
 REAL_VAR_now[5]  := My_REAL_05 ; 
 REAL_VAR_now[6]  := My_REAL_06 ; 
 REAL_VAR_now[7]  := My_REAL_07 ; 
 (* ------------------------------------------------- *) 
 
(* Add your integer, BOOL, Timer variables for retain here *) 
 (* ................................................. *) 
 OTHER_VAR_now[0]  := My_DINT_00 ; 
 OTHER_VAR_now[1]  := My_DINT_01 ; 
 OTHER_VAR_now[2]  := My_DINT_02 ; 
 OTHER_VAR_now[3]  := My_DINT_03 ; 
 OTHER_VAR_now[4]  := My_DINT_04 ; 
 OTHER_VAR_now[5]  := My_DINT_05 ; 
 
 OTHER_VAR_now[6]  := Any_to_DINT( My_BOOL_00 ) ; 
 OTHER_VAR_now[7]  := Any_to_DINT( My_BOOL_01 ) ; 
 OTHER_VAR_now[8]  := Any_to_DINT( My_BOOL_02 ) ; 
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測試程式: 

測試之前，請確認已設定好 PAC IP，再編譯/下載程式到 PAC 中 (若不熟悉操作，可參考 

Win-GRAF 快速上手手冊 - 2.3.4 節 與 2.3.5 節)，與 PAC 連線後，在觀測清單中 (Spy list， 

設定方式可參考 Win-GRAF 使用手冊 - 11.3 節) 一開始所有數值為 "0" (或 "FALSE")。 
 

註: "Save_file_counter" 會顯示寫入檔案的次數，若此數值變化很快 (例如: 每秒/分鐘寫入好 

幾次)，則不適合此應用 (因為頻繁地在 \System_disk 下寫入檔案，會降低  PAC 效能)。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

請任意的輸入幾個數值，當數值有變更時會在 PAC 內建立文字檔並將資料寫入到該檔案中。 

(\System_disk\Win-GRAF\retain_real.txt 與 retain_other.txt) 

 OTHER_VAR_now[9]  := Any_to_DINT( My_Timer_00 ) ; 
 OTHER_VAR_now[10] := Any_to_DINT( My_Timer_01 ) ; 
 OTHER_VAR_now[11] := Any_to_DINT( My_Timer_02 ) ; 
 OTHER_VAR_now[12] := Any_to_DINT( My_Timer_03 ) ; 
 OTHER_VAR_now[13] := Any_to_DINT( My_Timer_04 ) ; 
 OTHER_VAR_now[14] := Any_to_DINT( My_Timer_05 ) ; 
 (* ................................................. *) 
 

http://ftp.icpdas.com/pub/cd/win-graf-pac-cd/napdos/win-graf/manual/chinese/
http://ftp.icpdas.com/pub/cd/win-graf-pac-cd/napdos/win-graf/manual/chinese/
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Win-GRAF PAC 內: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

每寫入一次，值會加 1。 
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 1.5. 備份資料到 EEPROM 

Win-GRAF 系列 PAC 內建有一個 EEPROM 記憶體可供使用者用來讀取與寫入資料，此資料不會

因 PAC 關機而消失。相較於 SRAM 的讀寫方式，EEPROM 有以下優缺點: 

 

註: 有些 PAC 沒有 EEPROM 記憶體 (例如: WP-5238-CE7) 不支援 EEP_Read() 與 EEP_Write()。 

 

優點:  

提供 "可保存變數" (Retain Variable，參考 1.1 節) 之外，另一個可保存重要資料的方式。 

缺點:  

1. EEPROM 的讀寫動作很耗 CPU 時間 (約 5 ~ 50 ms)，而使用 "可保存變數" 方式， 

CPU 時間遠小於 1 ms。因此，請勿太頻繁的使用 "EEP_Read" 與 "EEP_Write" 函式， 

會增加許多 PAC Cycle 時間。 

2. EEPROM 有寫入限制 (視 PAC 而定)，並不適合對同一筆資料進行多次寫入，因此， 

請勿在每個 PAC Cycle 內呼叫 "EEP_Write" 函式來進行寫入動作。 

 
 

ST 語法:  (下列分為 安全 與 危險 寫法) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

     (* 宣告 "FIRST_CYCLE" 為 “BOOL” 變數且初始值為 “TRUE”。 

         宣告 "tmp_bool" 為 “BOOL” 變數。 

         宣告 "New_Val" 與 "Old_Val" 為 “DINT” 變數。 *) 

     (* 於第一個 Cycle 讀取 EEPROM 一次 *) 

 
     if  FIRST_CYCLE  then 

        FIRST_CYCLE  :=  FALSE ;  (* 表示不再是第一個 Cycle *) 

        tmp_bool :=  EEP_Read ( 1 , New_Val) ; 

     end_if ; 

 

     (* 安全寫法: 只有數值改變時才寫入到 EEPROM *) 

     if  New_Val <> Old_Val  then 

        Old_Val  :=  New_Val ; 

        tmp_bool :=  EEP_Write ( 1 , New_Val ) ; 

     end_if ;    
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 1.5.1. EEP_READ (讀取 EEPROM) 

 
 
 
 
 
 
 

Addr: (資料型態: “DINT”)  

位址可設定為 1 ~ 1200。若 "@Name" 參數的資料型態為 64-bit 資料 (例如: LINT 或 

LREAL)，則 "Addr" 只能設定為 1001 ~ 1200。 
 

@Name :  

指定一個變數名稱，用來儲存讀到的 EEPROM 的資料。 

(請勿使用字串變數，資料型態可為 BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, 

DWORD, REAL, TIME, LINT, LREAL。) 
 

Q:   

資料型態為 “BOOL”，“TRUE”: 表示 OK   ;   “FALSE”: 表示錯誤。 

若 "@Name" 參數的資料型態為 "REAL" 或 "LREAL"，當讀取的資料不是實數或有其它錯誤發

生，"Q" 會回傳 "FALSE"。若此資料非實數資料，"REAL" 或 "LREAL" 變數將會讀到 "0.0"。 

 

使用小技巧:   

按 “F1” 鍵，可查看詳細的設定說明。 

    (* 危險寫法: EEPROM 可能很快被損毀 *)      

     (* 宣告 "FIRST_CYCLE" 為 “BOOL” 變數且初始值為 “TRUE”。 

         宣告 "tmp_bool" 為 “BOOL” 變數。 

         宣告 "New_Val" 與 "Old_Val" 為 “DINT” 變數。 *) 

      (* 於第一個 Cycle 讀取 EEPROM 一次 *) 

     if  FIRST_CYCLE  then 

        FIRST_CYCLE  :=  FALSE ;  (* 表示不再是第一個 Cycle *) 

        tmp_bool  :=  EEP_Read ( 1 , New_Val) ; 

     end_if ; 

    (* 危險寫法:  於每個 Cycle  內將 "New_Val" 值寫入到 EEPROM 一次 *) 

     tmp_bool  :=  EEP_Write ( 1 , New_Val ) ;   
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 1.5.2. EEP_WRITE (寫入 EEPROM) 

 
 
 
 
 
 
 

Addr: (資料型態: “DINT”)  

位址可設定為 1 ~ 1200。若 "Value" 參數的資料型態為 64-bit 資料 (例如: LINT 或 LREAL)，

則 "Addr" 只能設定為 1001 ~ 1200。 
  

Value :  

將資料寫入 EEPROM。 

(請勿使用字串變數，資料型態可為 BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, 

DWORD, REAL, TIME, LINT, LREAL。) 
 

Q:   

資料型態為 “BOOL”，“TRUE”: 表示 OK   ;   “FALSE”: 表示錯誤。 
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